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ABSTRAK

Kompetensi mengoperasikan mesin produksi dengan kendali PLC merupakan
kompetensi yang wajib dikuasai oleh siswa SMK jurusan Teknik Instalasi Tenaga
Listrik. Di SMK N 1 Kandeman Batang, ada beberapa unit PLC yang disediakan sebagai
media praktikum pada proses pembelajaran, namun unit PLC masih belum bisa
digunakan sebagai media praktikum. Dengan tidak adanya media praktikum yang sesuai
untuk mengaplikasikan teori tentang PLC yang diberikan oleh guru, maka proses
pembelajaran menjadi tidak optimal. Tujuan penelitian ini adalah Mengetahui kelayakan
trainer dan jobsheet yang digunakan sebagai media pembelajaran dan Mengetahui
perbedaan hasil belajar antara siswa yang melaksanakan praktikum menggunakan
trainer dan jobsheet untuk mata pelajaran sistem kendali elektronik dengan hasil belajar
siswa yang tidak melaksanakan praktikum menggunakan trainer kit di Jurusan Teknik
Instalasi Tenaga Listrik SMK N 1 Kandeman Batang.

Desain penelitian yang digunakan adalah eksperimen semu (Quasi Exsperimental
Design), digunakan bertujuan untuk mengungkapkan hubungan sebab akibat dengan
cara melibatkan kelompok kontrol disamping eksperimen, namun pemilah kedua
kelompok tersebut tidak dengan teknik random. Model desain yang digunakan dalam
penelitian ini yaitu Non-Equivalen Control Group Design, artinya bahwa kedua kelas
akan diberikan pretest untuk mengukur kesebandingan antara kelas eksperimen dan
kelas kontrol sedangkan posttest untuk mengukur hasil dari pembelajaran pada kelas
eksperimen dan kelas kontrol. Dalam pelaksanaan penelitian ini kedua kelas
dikondisikan agar tidak saling berhubungan dengan diberlakukannya control group
design.

Hasil penelitian ini berupa trainer kit PLC mendapatkan nilai 88% dari ahli
materi dan 81,6% dari ahli media yang dikategorikan “Sangat Layak”. Artinya, trainer
kit PLC ini layak untuk digunakan sebagai media pembelajaran pada materi ajar sistem
kendali elektronik kompetensi dasar pelajaran mengoperasikan mesin produksi di SMK
N 1 Kandeman Batang. Sedangkan analisis data hasil belajar siswa dari ranah kognitif,
ranah psikomotorik dan ranah afektif pada kelas eksperimen sebesar 86,1% dan kelas
kontrol sebesar 68,4%, dengan peningkatan hasil dari kelas kontrol dan kelas ekperimen
sebesar 17,7%, maka hipotesis pada penelitian ini Ho ditolak dan Ha diterima, yang
artinya penggunaan trainer kit PLC sebagai media pembelajaran pada kelas eksperimen
dianggap efektif meningkatkan hasil belajar siswa tentang pemrograman PLC dengan
hasil ≥ 75% dari keseluruhan siswa dalam tes ranah kognitif, ranah psikomotorik dan
ranah afektif.
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BAB I

PENDAHULUAN

1.1 Latar Belakang

Peningkatan kualitas pendidikan merupakan hal yang tidak akan habis

dibicarakan dan diupayakan. Diantara upaya peningkatan kualitas pendidikan

tersebut adalah penerapan proses pembelajaran yang efektif dan menarik bagi

siswa.

Proses pembelajaran yang efektif, menyenangkan, menarik dan bermakna

bagi siswa dipengaruhi oleh berbagai unsur antara lain guru yang memahami

secara utuh hakekat, sifat, dan karakteristik siswa, metode pembelajaran yang

berpusat pada kegiatan siswa, saran belajar siswa yang memadai, tersedianya

berbagai sumber belajar dan media yang menarik yang mampu mendorong siswa

untuk belajar, dan lain-lain. Secara khusus, tersedianya berbagai sumber belajar

akan mendukung terhadap penciptaan kondisi belajar siswa yang menarik dan

menyenangkan. Salah satu sumber belajar tersebut adalah media pembelajaran

(Riyana, 2012: 3).

Kompetensi mengoperasikan mesin produksi dengan kendali PLC

merupakan kompetensi yang wajib dikuasai oleh siswa SMK jurusan Teknik

Instalasi Tenaga Listrik. Kompetensi yang dimaksud mencakup pengetahuan,
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keterampilan dan sikap kerja yang benar berkaitan dengan penggunaan PLC

untuk membantu dalam proses pembelajaran pada mata pelajaran PLC tersebut.

Berdasarkan hasil observasi ketika mengikuti program praktikum di SMK N

1 Kandeman Batang Jurusan Teknik Instalasi Tenaga Listrik (TITL) diketahui

bahwa jurusan ini baru meluluskan angkatan pertama pada tahun 2015, dan dalam

proses pembelajaran pada mata pelajaran mengoperasikan mesin produksi dengan

PLC masih dijelaskan sebatas teori. Adapun praktiknya menggunakan peralatan

PLC yang belum berupa trainer, artinya belum dalam bentuk satu kesatuan

komponen yang saling terikat, hanya sebatas alat PLC dengan pemrogramannya.

Guru mata pelajaran yang mengajar mata pelajaran PLC pun terkadang

mengeluhkan bahwa proses pembelajaran menjadi kurang efektif karena

permasalahan tersebut dan juga merasa tertinggal dalam segi fasilitas penunjang

praktikum. Demikian halnya para siswa, mereka sangat antusias ingin belajar

mengoperasikan PLC yang real.

Di SMK N 1 Kandeman Batang sudah ada beberapa unit PLC yang

disediakan sebagai media praktikum pada proses pembelajaran, namun unit PLC

masih belum bisa digunakan sebagai media praktikum. Dengan tidak adanya

media praktikum yang sesuai untuk mengaplikasikan teori tentang PLC yang

diberikan oleh guru, maka proses pembelajaran menjadi tidak optimal.

Dari uraian latar belakang permasalahan diatas, maka disusunlah sebuah

penelitian dengan judul “Penerapan Trainer Kit Programmable Logic Controller

(PLC) Sebagai Media Pemeblajaran pada Materi Ajar Sistem Kendali Elektronik
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di Jurusan Teknik Instalasi Tenaga Listrik (TITL) SMK Negeri 1 Kandeman

Batang”.

1.2 Identifikasi Masalah

1. Belum adanya media pembelajaran berupa trainer kit PLC di SMK N 1

Kandeman Batang.

2. Tanpa adanya trainer kit PLC yang digunakan sebagai media

pembelajaran membuat waktu pembelajaran materi ajar sistem kendali

elektronik menjadi tidak efisien.

1.3 Pembatasan Masalah

1. Media pembelajaran ini diperuntukkan bagi siswa kelas XII Jurusan

Teknik Instalasi Tenaga Listrik SMK N 1 Kandeman Batang.

2. Penelitian ini hanya mengambil sampel 64 siswa Jurusan Teknik Instalasi

Tenaga Listrik SMK N 1 Kandeman Batang.

3. Trainer ini menggunakan PLC Omron tipe CP1E-N20DR-A dan

menggunakan software aplikasi dari Omron yaitu CX-Programmer

version 9.3 yang terintegrasi dalam CX-One version 4.20.

1.4 Rumusan Masalah

1. Bagaimana mengetahui kelayakan trainer kit yang digunakan sebagai

media pembelajaran di Jurusan Teknik Instalasi Tenaga Listrik SMK N 1

Kandeman Batang?
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2. Bagaimanakah efektifitas peningkatan hasil belajar antara siswa yang

melaksanakan praktek menggunakan trainer kit untuk materi ajar sistem

kendali elektronik dengan hasil belajar siswa yang tidak melaksanakan

praktikum menggunakan trainer kit?

1.5 Tujuan Penelitian

1. Mengetahui kelayakan trainer kit yang digunakan sebagai media

pembelajaran di Jurusan Teknik Instalasi Tenaga Listrik SMK N 1

Kandeman Batang.

2. Mengetahui efektifitas peningkatan hasil belajar antara siswa yang

melaksanakan praktikum menggunakan trainer kit untuk mata pelajaran

sistem kendali elektronik dengan hasil belajar siswa yang tidak

melaksanakan praktikum menggunakan trainer kit.

1.6 Manfaat Penelitian

1. Bagi Peneliti, penelitiaan ini dapat memberikan gambaran dan

pengetahuan dalam pembuatan trainer kit PLC di Jurusan Teknik

Instalasi Tenaga Listrik SMK N 1 Kandeman Batang.

2. Bagi peserta didik, mampu menguasai kompetensi mengoperasikan

mesin produksi dengan kendali PLC dengan bantuan trainer kit PLC.

3. Bagi guru, penelitiaan ini dapat memberikan kontribusi dalam

pembelajaran untuk meningkatkan prestasi belajar siswa.
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4. Bagi peneliti lain, penelitiaan ini diharapkan dapat dijadikan sebagai

acuan untuk mengembangkan pembuatan trainer kit dalam rangka

meningkatkan mutu pendidikan.

1.7 Penegasan Istilah

1. Rancang bangun

Menurut Kamus Besar Bahasa Indonesia (KBBI, 2005), pengertian

penerapan adalah perbuatan menerapkan. Sedangkan menurut beberapa

ahli berpendapat, penerapan adalah suatu perbuatan mempraktekkan

suatu teori, metode, dan hal lain untuk mencapai tujuan tertentu dan

untuk suatu kepentingan yang diinginkan oleh suatu kelompok atau

golongan yang telah terencana dan tersusun sebelumnya.

2. Media Pembelajaran

Menurut (Arsyad, 2007: 3), kata ‘media’ berasal dari bahasa Latin

medius yang secara harfiah berarti tengah, perantara atau pengantar pesan

dari pengirim ke penerima pesan. Media dapat berupa software dan

hardware yang dapat digunakan untuk menyampaikan isi materi ajar dari

sumber belajar ke pelajar (individu atau kelompok), yang dapat

merangsang pikiran, perasaan, perhatian dan minat belajar sedemikian

rupa sehingga proses belajar menjadi lebih efektif.

3. Trainer

Menurut Hasan, S. (2006: 3), trainer merupakan suatu set peralatan di

laboratorium yang digunakan sebagai media pendidikan yang merupakan
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gabungan antara model kerja dan mock-up. Trainer ditunjukkan untuk

menunjang pembelajaran peserta didik dalam menerapkan pengetahuan /

konsep yang diperolehnya pada benda nyata. Model mock-up adalah

suatu penyerdehanaan bagian pokok dari suatu proses atau sistem yang

lebih awet.

4. Programmable Logic Controller(PLC)

Berdasarkan pada standar yang dikeluarkan oleh National Electrical

Association (NEMA) ICS3-1978 Part ICS3-304, PLC didefinisikan

sebagai berikut: “PLC adalah suatu peralatan elektronik yang bekerja

secara digital, memiliki memori yang dapat diprogram menyimpan

perintah-perintah untuk melakukan fungsi-fungsi khusus seperti logic,

squening, timing, counting, dan aritmatika untuk mengontrol berbagai

jenis mesin atau proses melalui analog atau digital input/output modules”.

5. Hasil Belajar

Menurut Sudjana (2010: 3), hasil belajar ialah perubahan tingkah laku

yang mancakup bidang kognitif , afektif, dan psikomotor tingkah yang

dimiliki peserta didik setelah menerima pengalaman belajar. Dari

pengertian tersebut hasil belajar terdiri dari tiga aspek, yaitu kognitif,

afektif dan psikomotor. Dapat juga dikatakan bahwa hasil belajar adalah

kemampuan yang dimiliki seseorang setelah menerima pengalaman

belajar. Hasil belajar juga merupakan penilaian yang dicapai untuk

mengetahui sejauh mana materi yang sudah diterima oleh siswa baik dari

aspek kognitif, afektif maupun psikomotor.
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1.8 Sistematis Skripsi

Secara garis besar, sistematika penelitian skripsi ini terdiri dari tiga bagian

utama, yaitu bagian awal, bagian pokok (isi) dan bagian akhir dengan susunan

sebagai berikut:

Bagian awal skripsi terdiri dari halaman judul, pernyataan, pengesahan,

motto dan persembahan, kata penghantar, abstrak, daftar isi, daftar tabel, daftar

gambar dan daftar lampiran.

Bagian isi skripsi terdiri dari lima bab, yaitu pendahuluan, landasan teori,

metode peneitian, hasil dan pembahasan, serta penutup.

Bab I pendahuluan, yang berisi latar belakang, rumusan masalah, tujuan,

batasan masalah, manfaat penelitian, penegasan istilah, dan sistematika skripsi.

Bab II landasan teori, merupakan tinjauan pustaka yang terdiri dari landasan

teori dan kerangka berfikir.

Bab III metodologi penelitian, yang terdiri dari metode dan desain penelitian,

populasi dan sampel penelitian, variabel penelitian, instrumen penelitian, teknik

pengumpulan data, teknik analisis data, prosedur dan alur penelitian, dan waktu

penelitian.

Bagian akhir skripsi terdiri atas daftar pustaka dan lampiran, daftar pustaka

berisi semua bahan kepustakaan yang digunakan sebagai rujukan langsung dalam

penelitian skripsi, sedangkan lampiran berisi data-data yang mendukung

penelitian skripsi.
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BAB II

LANDASAN TEORI

2.1 Kajian Teori

2.1.1 Media Pembelajaran dalam Proses Belajar Mengajar

2.1.1.1 Proses Belajar Mengajar

Proses belajar mengajar atau proses pengajaran merupakan suatu

kegiatan melaksanakan kurikulum suatu lembaga pendidikan, agar dapat

mempengaruhi para siswa mencapai tujuan pendidikan yang telah ditetapkan.

Tujuan pendidikan pada dasarnya mengantarkan para siswa menuju pada

perubahan-perubahan tingkah laku baik intelektual, moral maupun sosial agar

hidup mandiri sebagai individu dan makhluk sosial dalam mencapai tujuan

tersebut siswa berinteraksi dengan lingkungan belajar yang diatur guru melalui

proses pengajaran Sudjana dan Rivai (2004: 1).

Pengertian belajar menurut Catharina (2007: 2) ialah proses penting bagi

perubahan perilaku manusia dan mencakup segala sesuatu yang dipikirkan dan

dikerjakan. Konsep belajar telah banyak didefinisikan oleh para pakar psikologi

sebagai berikut:

1. Gagne dan Berliner (1983) dalam Catharina (2007: 2) menyatakan

bahwa belajar merupakan proses dimata suatu organisme mengubah

perilakunya karena hasil dari pengalaman.
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2. Morgan et.al. (1986) dalam Catharina (2007: 2) menyatakan bahwa

belajar merupakan perubahan relatif permanen yang terjadi karena

hasil praktik atau pengalaman.

3. Slavin (1994) dalam Catharina (2007: 2)menyatakan bahwa belajar

merupakan perubahan individu yang disebabkan oleh pengalaman.

4. Gagne (1977) dalam Catharina (2007: 3) menyatakan bahwa belajar

merupakan perubahan disposisi atau kecakapan manusia, yang

berlangsung selama periode waktu tertentu, dan perubahan perilaku

itu tidak berasal dari proses pertumbuhan.

Setelah mengerti dan memahami pengertian belajar dari berbagai pakar

psikologi maka belajar terbagi dari berbagai unsur seperti yang dijelaskan oleh

Gagne (1977) dalam Catharina (2007: 3) belajar merupakan sebuah sistem yang

didalamnya terdapat unsur yang berkaitan sehingga menghasilkan perubahan

perilaku.

Adapun komponen-komponen pembelajaran tersebut meliputi:

1. Tujuan Pengajaran

Tujuan pengajaran adalah sejumlah hasil pengajaran yang dinyatakan

dalam artian siswa belajar, yang secara umum mencakup pengetahuan

baru, keterampilan dan kecakapan, serta sikap baru yang diharapkan oleh

guru dan dapat dicapai oleh siswa sebagai hasil pengajaran.

2. Siswa

Siswa adalah mereka yang sedang mengikuti program pendidikan

pada suatu sekolah atau jenjang pendidikan tertentu.
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3. Guru

Guru yaitu orang yang memanfaatkan hasil perencanaan dan ikut

dalam perencanaan pengajaran, mengenal siswa dengan baik, menguasai

cara pengajaran dan persyaratan program pengajaran dengan bantuan

perancang, bertanggung jawab dalam mengujicobakan dan kemudian

menerapkan rencana pengajaran yang dikembangkan.

4. Perencanaan pengajaran

Perencanaan pengajaran meliputi memilih isi mata ajaran, menata

urutan topik, mengalokasikan waktu, memilih alat bantu dan prosedur

pengajaran, serta membuat ukuran untuk mengukur prestasi belajar siswa.

5. Strategi pembelajaran

Strategi pembelajaran merupakan cara-cara yang akan dipilih dan

digunakan oleh seorang pengajar untuk menyampaikan materi

pembelajaran sehingga akan memudahkan siswa menerima dan

memahami materi pembelajaran yang pada akhirnya tujuan pembelajaran

dapat dikuasai di akhir kegiatan belajar.

6. Media pembelajaran

Media pembelajaran merupakan piranti yang memegang peranan

tersendiri dalam proses pembelajaran.

7. Evaluasi pengajaran

Evaluasi pengajaran mencakup evaluasi hasil, proses pelaksanaan,dan

faktor-faktor manajerial pengajaran pendukung proses pengajaran. Proses
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evaluasi dikelompokan menjadi tiga ranah, yaitu pengetahuan intelektual,

keterampilan dan perilaku.

2.1.1.2 Efektivitas Pembelajaran

Efektifitas berasal dari kata dasar efektif. Menurut Kamus Besar Bahasa

Indonesia (1990:219), kata efektif mempunyai arti efek, pengaruh, akibat atau

dapat membawa hasil. Jadi efektifitas adalah keaktifan, daya guna, adanya

kesesuaian dalam suatu kegiatan orang yang melaksanakan tugas dengan sasaran

yang dituju.

Menurut Popham (dalam Ramadhani, 2012: 9), efektifitas proses

pembelajaran seharusnya ditinjau dari hubungan guru tertentu yang mengajar

kelompok siswa tertentu, didalam situasi tertentu dalam usahanya mencapai

tujuan-tujuan instruksional tertentu. Efektifitas proses pembelajaran berarti tingkat

keberhasilan guru dalam mengajar kelompok siswa tertentu dengan menggunakan

metode tertentu untuk mencapai tujuan instruksional tertentu.

Dunne (dalam Ramadhani, 2012: 9) berpendapat bahwa efektifitas

pembelajaran memiliki dua karakteristik. Karakteristik pertama ialah

“memudahkan murid belajar” sesuatu yang bermanfaat, seperti fakta,

keterampilan, nilai, konsep atau sesuatu hasil belajar yang diinginkan. Kedua,

bahwa keterampilan diakui oleh mereka yang berkompeten menilai, seperti guru,

pengawas, tutor atau murid sendiri.
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Pendapat yang menyatakan tentang indikator sesuatu bisa dikatakan

efektif:

1. Menurut Sinambela (dalam Ramadhani, 2012: 10), pembelajaran

dikatakan efektif apabila mencapai sasaran yang diinginkan, baik

dari segi tujuan pembelajaran maupun prestasi siswa yang maksimal.

Beberapa indikator keefektifan pembelajaran:

1) Ketercapaian ketuntasan belajar (75).

2) Ketercapaian keefektifan aktivitas siswa.

3) Ketercapaian efektifitas kemampuan guru mengelola

pembelajaran, dan respon siswa terhadap pembelajaran yang

positif.

2. Menurut Wotruba dan Wright dalam Yusufhadi Miarso (dalam

Ramadhani, 2012: 10), indikator yang dapat digunakan untuk

menentukan efektifitas dalam proses pembelajaran adalah:

1) Pengorganisasian materi yang baik.

2) Komunikasi yang efektif.

3) Penguasaan dan antusiasme terhadap materi pelajaran.

4) Sikap positif terhadap siswa.

5) Pemberian nilai yang adil.

6) Keluwesan dalam pendekatan pembelajaran.

7) Hasil belajar siswa yang baik.

Berdasarkan uraian yang telah disebutkan di atas, dapat disimpulkan

bahwa efektifitas pembelajaran adalah tingkat keberhasilan yang dapat dicapai
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dari suatu metode pembelajaran tertentu sesuai dengan tujuan pembelajaran yang

telah direncanakan. Tingkat keberhasilan yang digunakan pada penelitian ini

adalah indikator ketuntasan hasil belajar siswa.

2.1.1.3 Hasil Belajar

Hasil belajar menggambarkan siswa dalam memperoleh kompetensi yang

telah diajarkan dari tujuan pembelajaran yang ditentukan. Hal ini sejalan dengan

Sudjana (2013: 22) menyatakan bahwa “Hasil belajar merupakan kemampuan-

kemampuan yang dimiliki peserta didik setalah mengikuti proses pembelajaran”.

Sehingga hasil belajar adalah target dimana peserta didik telah selesai dalam

melaksanakan proses pembelajaran dan dinyatakan dalam kompeten dan tidak

kompeten.

Hasil belajar menurut Bloom (dalam Wibiksana, 2013: 23),

diklasifikasikan kedalam tiga ranah, yaitu:

1. Ranah kognitif

Hasil belajar kognitif mengacu pada hasil belajar yang berkenaan

dengan pengembangan kemampuan dan penalaran siswa. Hasil belajar

kognitif berhubungan dengan kemampuan intelektual atau kemampuan

berpikir siswa, seperti kemampuan mengingat dan kemampuan

memecahkan masalah.
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2. Ranah Afektif

Hasil belajar afektif mengacu kepada sikap dan nilai yang

diharapkan dikuasai siswa setelah mengikuti pembelajaran. Tipe hasil

belajar afektif tampak pada siswa dalam berbagai tingkah laku, seperti

perhatian terhadap pelajaran, disiplin, kebiasaan belajar, dan motivasi

belajar.

3. Ranah Psikomotorik

Hasil belajar psikomotorik tampak dalam bentuk keterampilan dan

kemampuan bertindak siswa.

Berdasarkan penjelasan dari para ahli tentang definisi hasil belajar,

peneliti menyimpulkan bahwa hasil belajar adalah prestasi yang dimilki siswa

secara individu maupun tim setelah menerima pengalaman belajar berupa ranah

kognitif, afektif, dan psikomotorik.

Hasil belajar yang diharapkan dicapai oleh siswa, khususnya siswa SMK

Negeri 1 Kandeman Batang, adalah dapat memenuhi aspek kognitif.

2.1.1.4 Pengertian Media Pembelajaran

Dalam bahasa Arab, media adalah perantara atau pengantar pesan dari

pengirim kepada penerima pesan. Menurut Gerlach dan Ely (dalam Arsyad, 2014:

3) mengatakan, apabila dipahami secara garis besar, maka media adalah manusia,

materi, atau kejadian yang membangun suatu kondisi atau membuat siswa mampu
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memperoleh pengetahuan, keterampilan atau sikap. Dalam pengertian ini, guru,

buku teks, dan lingkungan sekolah merupakan media.

Media Pembelajaran merupakan wadah dari pesan, materi yang ingin

disampaikan adalah pesan pembelajaran, tujuan yang ingin dicapai ialah proses

pembelajaran. Selanjutnya penggunaan media secara kreatif akan memperbesar

kemungkinan bagi siswa untuk belajar lebih banyak, menjadikan apa yang

dipelajari lebih baik, dan meningkatkan penampilan dalam melakukan

keterampilan sesuai dengan yang menjadi tujuan pembelajaran (Riyana, 2012: 11).

Menurut Susilana (2007: 9) kegunaan media dalam pembelajaran sebagai

berikut:

1. Memperjelas pesan agar tidak terlalu verbalitas.

2. Mengatasi keterbatasan ruang, waktu, tenaga dan daya indra.

3. Menimbulkan gairah belajar, interaksi lebih langsung antara murid

dengan sumber belajar.

4. Memungkinkan anak belajar mandiri sesuai dengan bakat dan

kemampuan visual, auditori, dan kinestetiknya.

5. Memberi rangsangan yang sama, mempersamakan pengalaman dan

menimbulkan persepsi yang sama.

Berdasarkan uraian tersebut, maka dapat disimpulkan bahwa media

pembelajaran adalah segala sesuatu yang dapat digunakan untuk menyampaikan

pesan atau informasi dalam proses belajar mengajar sehingga dapat merangsang

perhatian dan minat siswa dalam belajar.
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2.1.1.5 Fungsi Media Pembelajaran

Di dunia pendidikan, fungsi utama media pembelajaran adalah sebagai

alat bantu mengajar yang turut mempengaruhi iklim, kondisi, dan lingkungan

belajar yang ditata dan diciptakan oleh guru (Arsyad, 2011: 15). Pemakaian media

pembelajaran dalam proses belajar mengajar dapat membangkitkan keinginan dan

minat yang baru, membangkitkan motivasi dan rangsangan kegiatan belajar, dan

bahkan membawa pengaruh-pengaruh psikologis terhadap siswa (Hamalik dalam

Kustandi dan Sutjipto, 2016: 19).

Penggunaan media pembelajaran pada tahap orientasi pembelajaran

sangat membantu siswa meningkatkan pemahaman, menyajikan data dengan

menarik dan terpercaya, memudahkan penafsiran data, memadatkan informasi,

serta membangkitkan motivasi dan minat siswa dalam belajar (Kustandi dan

Sutjipto, 2016: 19). Menurut Kemp dan Dayton (dalam Kustandi dan Sutjipto,

2016: 20), media pembelajaran dapat memenuhi tiga fungsi utama, yaitu dalam

hal 1) memotivasi minat dan tindakan, 2) menyajikan informasi, dan 3) memberi

instruksi.

Pendapat Kem dan Dayton kemudian diperkuat oleh penjelasan Arif

Sadiman, dkk. tentang fungsi media. Menurut Arif Sadiman, dkk. (2011)

kegunaan media pembelajaran adalah:

1. Memperjelas penyajian pesan agar tidak terlalu bersifat verbalistis.

2. Mengatasi keterbatasan ruang, waktu dan daya indera.

3. Penggunaan media pembelajaran yang tepat dan bervariasi dapat

mengatasi sikap pasif anak didik.
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4. Memberikan perangsang belajar yang sama.

5. Menyamakan pengalaman.

6. Menimbulkan persepsi yang sama.

2.1.1.6 Pengembangan Media Pembelajaran

Menurut Sanjaya (2012: 103, 104), media pembelajaran harus

dikembangkan agar mampu memberikan pesan yang tertanam dalam setiap

individu. Dengan kata lain pesan yang disuguhkan tidak mudah untuk dilupakan.

Pesan itu harus mudah dicerna sehingga memori setiap individu akan mudah

melahap setiap informasi yang disuguhkan serta mampu diungkapkan kembali

manakala diperlukan.

Menurut siddiq (2008: 1-28), bahan pembelajaran dapat didesain dalam

berbagai macam format. Ada bahan pembelajaran dalam bentuk bahan cetak,

audio, video, bahan pembelajaran berbasis komputer (CAI), dan berbagai bentuk

alat trainer dan media pembelajaran. dari beberapa format tersebut dapat

diklasifikasikan dalam dua macam, yaitu format bahan pembelajaran dengan

kompen lengkap dan komponen tidak lengkap. Bahan pembelajaran dalam bentuk

komponen lengkap, didesain untuk pembelajaran mandiri, sedangkan bahan

pembelajaran komponen tidak lengkap adalah bahan pembelajaran dalam bentuk

alat trainer/media pembelajaran yang digunakan guru sebagai alat bantu faktor

pendukung komponen pembelajaran lain. Bahan pembelajaran dalam bentuk alat

trainer pembelajaran dan media pembelajaran diklasifikasikan dalam beberapa

kelompok:
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1. Bahan pembelajaran berbentuk media visual, seperti gambar, foto,

peta, globe,

2. Bahan pembelajaran audio, seperti radio, CD audio, kaset rekaman,

piringan hitam,

3. Bahan pembelajaran audio-visual, seperti televisi, film, video, CD

audio-visual,

4. Bahan pembelajaran dalam bentuk benda-benda nyata yang dapat

diperoleh dari lingkungan sekitar,

5. Bahan pembelajaran cetak, seperti buku, modul, surat kabar, majalah,

buletin, jobsheet.

Berdasarkan ulasan mengenai pengembangan media pembelajaran di atas,

maka dapat disimpulkan bahwa media pembelajaran harus dikembangkan agar

mampu memberikan pesan yang tertanam dan mudah dicerna dalam memori

setiap individu, tidak mudah untuk dilupakan, dan mampu diungkapkan kembali

manakala diperlukan.

2.1.1.7 Kriteria Kelayakan Media Pembelajaran

Dari pendapat tentang pemilihan media bahwa media yang baik adalah

media yang dapat mempertimbangkan optimalisasi pencapaian tujuan

pembelajaran. Sehingga rujukan dan kriteria utama memilih media adalah

kontribusi media dalam meningkatkan keberhasilan pembelajaran. Selain itu

media yang dipilih seharusnya media yang benar-benar layak digunakan untuk

pembelajaran.
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Menurut Badan Standar Nasional Pendidikan (dalam Hidayati, 2013: 27-

28), kriteria kelayakan sebuah media yang baik dapat ditinjau dari kriteria-kriteria

berikut ini.

1. Kelayakan isi; instrumen penilaian kelayakan isi terdiri dari cakupan

materi, akurasi materi, kemutakhiran, mengandung wawasan

produktivitas, merangsang keingintahuan, mengembangkan

kecakapan hidup, mengembangkan wawasan

kebinekaan,mengandung wawasan kontekstual.

2. Kelayakan kebahasaan; instrumen penilaian kelayakan kebahasaan

meliputi sesuai dengan perkembangan peserta didik, komunikatif,

dialogis dan interaktif, lugas, koherensi dan keruntutan alur pikir,

kesesuaian dengan kaidah bahasa Indonesia, penggunaan istilah dan

symbol/lambang.

3. Kelayakan penyajian; instrumen penilaian kelayakan isi terdiri dari

teknik penyajian, pendukung penyajian materi, dan penyajian

pembelajaran.

Sedangkan menurut Amrulloh dkk. (2013: 134-136), untuk menghasilkan

media yang layak secara teoritis, media harus ditelaah oleh ahli media, ahli materi

dan siswa. Kelayakan teoritis media ditinjau dari kelayakan materi dan kelayakan

media. Kelayakan materi meliputi kesesuaian isi media dengan tujuan

pembelajaran. Sedangkan kelayakan media meliputi format media, kualitas media,

dan kesesuaian konsep.
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2.1.1.8 Pengelompokkan Media Pembelajaran

Dalam perjalanannya, perkembangan media pembelajaran mengikuti arus

perkembangan teknologi. Berdasarkan perkembangan teknologi yang muncul,

Kustandi dan Sutjipto (2016: 29-31) membagi media pembelajaran menjadi empat

kelompok, yaitu:

1. Media Hasil Teknologi Cetak

Teknologi cetak adalah cara untuk menghasilkan atau

menyampaikan materi, seperti buku dan materi visual statis, terutama

melalui proses pencetakan mekanis atau fotografis. Materi cetak dan

visual merupakan dasar pengembangan dan penggunaan kebanyakan

materi pembelajaran lainnya.

Kelebihan dan kelemahan media cetak menurut Kustandi dan

Sutjipto (2016: 33-34) adalah sebagai berikut.

Kelebihan:

1) Siswa dapat belajar sesuai dengan kecepatan masing-masing.

2) Dapat mengulangi materi dalam media cetak sehingga akan

mengikuti ukuran pikiran secara logis.

3) Perpaduan teks dan gambar dapat menambah daya tarik, serta dapat

memperlancar pemahaman informasi yang disajikan dalam dua

format sekaligus, yaitu verbal dan visual.

Kelemahan:

1) Sulit menampilkan gerak dalam halaman media cetak.
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2) Biaya pencetakan mahal apabila ingin menampilkan ilustrasi,

gambar atau foto yang berwarna-warni.

3) Proses pencetakan media sering kali memakan waktu lama.

2. Media Hasil Teknologi Audio Visual

Teknologi audio visual merupakan cara menghasilkan atau

menyampaiakan materi dengan menggunakan mesin-mesin mekanis dan

elektronik, untuk menyajikan pesan-pesan audio dan visual.

Kelebihan dan kelemahan media audio visual (Kustandi dan Sutjipto,

2016: 62) adalah sebagai berikut.

Kelebihan:

1) Dapat menjangkau kelompok besar.

2) Perhatian anak dapat dipusatkan pada objek tertentu.

3) Memiliki kemampuan untuk menampilkan warna, gerak, dan

suara.

Kelemahan:

1) Listrik pada ruang penyajian harus tersedia.

2) Harga perangkat elektronik lumayan mahal.

3. Media Hasil Teknologi Bebasis Komputer

Teknologi berbasis komputer merupakan cara menghasilkan atau

menyampaikan materi dengan menggunakan sumber-sumber yang

berbasis mikro-processor.
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Beberapa keuntungan dan keterbatasan komputer yang digunakan

untuk tujuan-tujuan pendidikan adalah sebagai berikut. (Kustandi dan

Sutjipto, 2016: 67-68).

Keuntungan:

1) Kendali berada di tangan siswa, sehingga tingkat kecepatan belajar

siswa dapat disesuaikan dengan tingkat penguasaannya.

2) Komputer dapat merangsang siswa untuk mengerjakan latihan dan

melakukan kegiatan laboratorium atau simulasi. Hal ini karena

tersedianya animasi grafik, warna, dan musik dalam komputer

sehingga dapat menambah realisme.

3) Komputer dapat mengakomodasi siswa yang lamban menerima

pelajaran karena ia dapat memberikan iklim yang lebih afektif

dengan cara yang lebih individual, tiak pernah lupa, tidak pernah

bosan sangat sabar dalam menjalankan instruksi seperti yang

diinginkan program yang digunakan.

Keterbatasan:

1) Pengembangan perangkat lunak komputer relatif mahal.

2) Untuk menggunakan komputer, diperlukan pengetahuan dan

keterampilan khusus tentang komputer.

3) Komputer hanya efektif bila digunakan oleh satu orang atau

beberapa orang dalam kelompok kecil.

4. Media Hasil Gabungan Teknologi Cetak dan Komputer
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Teknologi gabungan adalah cara untuk menghasilkan dan

menyampaikan materi yang menggabungkan pemakaian beberapa bentuk

media yang dikendalikan oleh komputer.

Seiring dengan perkembangan teknologi, media pembelajaran mengalami

perubahan yang signifikan. Media pembelajaran yang digunakan tidak hanya

dalam bentuk visual ataupun bentuk audio tetapi sudah berbentuk audio visual.

Dari berbagai macam media yang dapat digunakan sebagai media pembelajaran,

salah satu contoh media yang dapat dijadikan pilihan adalah trainer.

2.1.2 Trainer Pembelajaran

Trainer adalah alat-alat yang berfungsi untuk membantu efektifitas

penggunaan metode mengajar dalam mencapai tujuan pembelajaran (Soelaiman,

1979: 72). Dengan batasan ini dapat dipahami bahwa alat trainer bukan

menggantikan pengajar tetapi alat bantu dalam menunaikan proses belajar

mengajar.

Trainer merupakan benda-benda tiga dimensi yang dapat dilihat, disentuh

dan diraba oleh guru maupun siswa. Media ini dibuat untuk mengatasi

keterbatasan obyek maupun situasi sehingga proses pembelajaran tetap berjalan.

Pemodelan suatu benda yang memungkinkan untuk bisa dibuat dengan biaya yang

murah dapat didefinisikan sebagai proses pembentukan media dari suatu

sistem.(Fitrianto, 2014: 69-75).
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Trainer umumnya dipergunakan untuk mendukung kegiatan pengenalan

materi di dunia pendidikan. Tampilan dari trainer ini akan memperjelas sajian ide,

menggambarkan atau menghiasi fakta yang mungkin akan cepat dilupakan jika

tidak divisualkan (Fitrianto, 2014: 69-75).

Alasan mengapa trainer banyak digunakan di dunia pendidikan adalah

untuk mendukung metode pendidikan yang menggunakan metode penerapan

materi dengan cara praktek/uji coba. Karena metode pendidikan penyampaian

materi secara teori saja kurang efektif, maka ditingkatkan penyampaian materi

dengan menerapkan trainer pada kegiatan pembelajaran yang membutuhkan

tindakan praktek/uji coba untuk memperjelas konsep yang akan dijelaskan pada

materi tersebut. Karena pada dasarnya fungsi utama dari alat adalah untuk

menurunkan keabstrakan dari konsep, agar siswa mampu menangkap arti

sebenarnya konsep tersebut (Sanjaya dalam Hajir, 2014: 10).

Trainer berfungsi memperjelas dan membuat pelajaran menjadi lebih

nyata bagi penerima materi sehingga proses pembelajaran menjadi lebih efisien

dan efektif. Trainer merupakan alat peraga yang dipergunakan guna mendukung

kegiatan pelatihan, pengenalan materi, dan pendidikan. Umumnya alat trainer ini

lebih banyak dipergunakan pada dunia pendidikan, seperti SMP, SMA/SMK/STM

dampai dengan Universitas.

Menurut Sudjana (1998: 99) ada 5 pokok dari trainer dalam proses belajar

mengajar, yaitu:
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1. Penggunaan trainer dalam proses belajar berfungsi sebagai alat bantu

mewujudkan situasi belajar.

2. Penggunaan trainer merupakan bagian yang penting dari keseluruhan

situasi mengajar.

3. Trainer dalam pengajaran penggunaannya sesuai dengan tujuan dan isi

pelajaran.

4. Penggunaan trainer dalam pengajaran bukan semata-mata alat hiburan.

5. Penggunaan trainer dalam pengajaran diutamakan untuk mempertinggi

mutu belajar mengajar.

Menurut Sundayana (2015: 18) secara umum persyaratan trainer itu

adalah:

1. Tahan lama

2. Bentuk dan warna menarik

3. Sederhana dan mudah dikelola

4. Dapat menyajikan dan memperjelas konsep

5. Ukuran sesuai dengan kondisi fisik peserta didik

6. Fleksibel

Berdasarkan ulasan mengenai alat trainer dalam pembelajaran yaitu untuk

memenuhi serta mendukung penuh metode pendidikan yang menggunakan

metode penerapan materi dengan cara praktik atau uji coba. Karena metode

pendidikan dalam penyampaian materi secara teori saja kurang optimal, maka

ditingkatkan penyampaian materi secara optimal dengan menerapkan alat trainer

pada setiap kegiatan belajar mengajar antara pengajar dengan peserta didiknya.



26

2.1.2.1 Trainer Kit Programmable Logic Controller (PLC)

Trainer Kit Programmable Logic Controller (PLC) merupakan media

yang digunakan oleh guru sebagai media pembelajaran pada materi ajar sistem

kendali elektronik dengan PLC. Trainer kit PLC berbentuk koper ini yang sudah

terhubung dengan unit input dan output PLC, sehingga bisa diaplikasikan dengan

peralatan luar (misalnya motor, selenoid valve, buzzer, dan komponen output

lainnya. Bagi guru, trainer kit PLC membantu mewujudkan konsep dan

membantu memotivasi siswa belajar aktif.

2.1.2.2 Komponen Trainer kit Programmable Logic Controller (PLC)

Trainer kit PLC merupakan alat yang di dalamnya terdapat beberapa

komponen yang dirangkai sedemikian rupa sehingga rangkaian tersebut dapat

bekerja sesuai fungsinya. Trainer kit PLC ini terdiri dari tiga bagian, yaitu bagian

input, proses, dan output. Agar ketiga bagian dapat terhubung dan berfungsi

sebagaimana mestinya digunakan konektor berupa banana port.

Komponen yang digunakan diantaranya saklar sebagai input kendali,

konektor sebagai penghubung, Light Emitting Diode (LED) sebagai sinyal input

yang diseri dengan resistor sebagai pembatas arus, pilot lamp pada alat trainer kit

PLC ini sebagai sinyal output yang berperan sebagai lampu indikator yang

mengindikasikan/menunjukkan apakah rangkaian itu telah aktif.
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2.1.2.2.1 Saklar

Saklar adalah sebuah perangkat yang digunakan untuk memutuskan

jaringan listrik, atau untuk menghubungkannya. Jadi saklar pada dasarnya adalah

alat penyambung atau pemutus aliran listrik. Secara sederhana, saklar terdiri dari

dua bilah logam yang menempel pada suatu rangkaian, dan bisa terhubung atau

terpisah sesuai dengan keadaan sambung (on) atau putus (off) dalam rangkaian itu.

Jenis saklar yang digunakan pada rangkaian ini adalah saklar toggle.

Saklar toggle adalah saklar yang menghubungkan atau memutuskan arus dengan

cara menggerakkan tuas yang ada secara mekanis. Ukurannya relatif kecil dan

digunakan untuk arus yang kecil pula.

Gambar 2.1 Saklar Toggle

2.1.2.2.2 Konektor

Konektor adalah komponen yang berfungsi untuk menyambung satu

tempat ke tempat lain. Konektor sering digunakan dalam rangkaian elektronika,

untuk memudahkan melepas pasang rangkaian.

http://technopath20.blogspot.com/2013/06/apa-itu-elektronika.html
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Konektor yang digunakan pada rangkaian ini adalah jenis konektor

banana port yang terpasang pada trainer dan banana jack yang bertindak sebagai

penghubung dari satu bagian ke bagian lainnya.

Gambar 2.2 Banana Port dan Banana Jack

2.1.2.2.3 Light Emmiting Dioda (LED)

Light Emitting Diode (LED) merupakan dioda yang dapat

memancarkan cahaya. LED terbentuk dari bahan-bahan semikonduktor, yaitu

doping gallium, arsenic, dan phosphorus. Sifat LED menyerupai dioda yaitu

hanya bekerja pada satu arah saja yaitu ketika LED diberi bias maju (Forward

bias).

Meskipun sifat LED menyerupai dioda tetapi arus maksimum yang

dapat dilewatkan oleh LED hanya sebesar 20mA, jika arus yang melewati LED

melebihi nilai maksimum tersebut, LED akan rusak.

Dengan kemampuan melewatkan arus yang kecil tersebut, LED perlu

diberi tahanan berupa resistor yang dipasang secara seri yang berfungsi sebagai

pembatas arus.
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Gambar 2.3 Komponen dan Simbol LED

2.1.2.2.4 Resistor

Resistor disebut juga dengan tahanan atau hambatan, berfungsi untuk

menghambat (mengatur) arus listrik yang melewatinya. Satuan harga resistor

adalah ohm. Seperti yang sudah dijelaskan tentang penjelasan Light Emitting

Diode (LED) diatas, resistor dalam rangkaian trainer kit PLC ini digunakan

sebagai pembatas arus. Resistor dibagi menjadi dua macam, yaitu:

1. Resistor Variabel atau Potensiometer, yaitu resistornyang besar

hambatannya dapat diubah-ubah. Yang termasuk ke dalam

potensiometer ini antara lain: Resistor KSN (Koefisien Suhu

Negatif), Resistor Light Dependent Resistor (LDR) dan Resistor

Voltage Dependent Resistor (VDR). Gambar simbol dan contoh

bentuk fisik resistor variabel dapat dilihat pada gambar 2.4.

Gambar 2.4 Simbol Resistor Variabel/Potensiometer
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2. Resistor Tetap, yaitu resistor yang nilai hambatannya relatif tetap

biasanya terbuat dari karbon, kawat atau paduan logam. Nilai

hambatannya, ditentukan oleh tebalnya dan panjangnya lintasan

karbon. Panjang lintasan karbon tergantung dari kisarnya alur yang

berbentuk spiral. Gambar simbol dan contoh bentuk fisik resistor

tetap dapat dilihat pada gambar

(a)

(b)

Gambar 2.5(a) Simbol Resistor Tetap, (b) Resistor Tetap

2.1.2.2.5 Pilot Lamp Plastik 220 VAC (Lampu Indikator)

Sebuah pilot lamp atau dalam bahasa Indonesia lampu pilot merupakan

lampu LED yang biasa digunakan sebagai lampu indikator dalam rangkaian

sebuah alat atau mesin. Pilot lamp tersebut dapat bekerja sebagai mestinya jika

dialiri daya AC sebesar 220 VAC dengan toleransi 110 – 240 VAC. Warna yang

dihasilkan pilot lamp ini adalah lampu putih. Karena fungsinya sebagai lampu

indikator, pilot lamp ini dibuat warna warni sinarnya dengan menambahkan

penutup kaca yang berwarna sehingga tampak dari luar berwarna sinar yang

dihasilkan. Biasanya warna pilot lamp ini ada 3 macam yaitu merah (menandakan

panel listrik mati), hijau (panel listrik hidup), dan orange (panel listrik mengalami

konsleting).



31

Pilot lamp pada alat trainer kit PLC ini sebagai sinyal output yang

berperan sebagai lampu indikator yang mengindikasikan/menunjukkan apakah

rangkaian itu telah aktif. Output dari trainer PLC tersebut dihubungkan ke pilot

lamp ini jika rangkaian tersebut sudah benar maka ketika rangkaian aktif alat ini

akan aktif (nyala). Ketika pilot lamp tersebut menyala kita dapat mengetahui

bahwa rangkaian alat trainer kit PLC tersebut sudah benar atau aktif, karena

fungsinya sebagai lampu indikator pilot lamp ini akan bekerja jika dan hanya jika

mendapat aliran listrik.

Gambar 2.6 Pilot Lamp 220 VAC

2.1.3 Programmable Logic Controller (PLC)

2.1.3.1 Pengertian Programmable Logic Controller (PLC)

PLC bekerja dengan cara mengamati masukan (melalui sensor terkait),

kemudian melakukan proses dan melakukan tindakan sesuai yang dibutuhkan,

yang berupa menghidupkan atau mematikan keluarannya. Programmable Logic

Controller (PLC) diperkenalkan pertama kali pada tahun 1969 oleh Richard E.

Morley yang merupakan pendiri Modicon Corporation. Berdasarkan namanya

konsep PLC adalah sebagai berikut:
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1. Programmable yaitu menunjukkan kemampuannya yang dapat

dengan leluasa mengubah program yang dibuat dan kemampuannya

dalam hal memori program yang telah dibuat.

2. Logic yaitu menunjukkan kemampuannya dalam memproses input

secara ALU (Arithmetic and Logic Unit) dengan melakukan operasi

membandingkan, menjumlahkan, mengalihkan, membagi,

mengurangi, dan negasi.

3. Controller yaitu menunjukkan kemampuan dalam mengontrol dan

mengatur proses sehingga menghasilkan output yang diinginkan.

Menurut Capiel (1982) PLC adalah sistem elektronik yang beroperasi

secara digital dan didesain untuk pemakaian di lingkungan industri, dimana sistem

ini menggunakan memori yang dapat diprogram untuk penyimpanan secara

internal instruksi-instruksi yang mengimplementasikan fungsi-fungsi spesifik

seperti logika, urutan, perwaktuan, pencacahan dan operasi aritmatik untuk

mengontrol mesin atau proses melalui modul-modul I/O digital maupun analog.

Menurut Frank D. Petruzella (2001:596) Programmable Logic Controller

(PLC) didefinisikan sebagai komputer yang dirancang untuk penggunaan pada

mesin. Tidak seperti komputer, pengontrol ini telah dirancang untuk bekerja pada

lingkungan industri dan dilengkapi dengan input/output khusus dan pengendali

bahasa pemrograman. Singkatan umum, PC yang digunakan pada industri untuk

piranti tersebut, dapat menjadi rancu karena ini juga singkatan untuk personal

computer (komputer pribadi). Oleh karena itu, beberapa pembuat menamakan
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pengontrol yang dapat diprogram sebagai PLC, yang merupakan singkatan dari

(Programmable Logic Controller).

Menurut National Electrical Manufacturing Assosiation (NEMA) PLC

didefinisikan sebagai suatu perangkat elektronik digital dengan memori yang

dapat diprogram untuk menyimpan instruksi-instruksi yang menjalankan fungsi-

fungsi spesifik seperti: logic, sekuencing, timing, counting, dan aritmatika untuk

mengontrol suatu proses terus menerus sesuai variabel masukan dan memberikan

keputusan sesuai keinginan pemrograman sehingga nilai keluaran tetap terkontrol

Sehingga PLC dapat diartikan sebuah alat kontrol yang bekerja

berdasarkan pada pemrograman dan eksekusi instruksi-instruksi untuk

menjalankan fungsi-fungsi khusus seperti logika, pewaktu, pencacah, dan

aritmatika, yang mempunyai kemampuan dalam mengontrol berbagai jenis mesin

atau proses melalui input dan output digital atau analog, dan mengatur proses

sehingga menghasilkan output yang diinginkan.

Gambar 2.7 Programmable Logic Controller (PLC)
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2.1.3.2 Fungsi Programmable Logic Controller (PLC)

Fungsi kegunaan dari PLC dapat dikatakan hampir tidak terbatas

(Agfianto, 2004). Tapi dalam prakteknya dapat dibagi secara umum dan khusus.

Secara umum fungsi dari PLC adalah sebagai berikut:

1. Sekuensial control, PLC memproses input sinyal biner menjadi output

yang digunakan untuk keperluan pemrosesan teknik secara berurutan

(sekuensial), disini PLC menjaga agar semua step atau langkah dalam

proses sekuensial berlangsung dalam urutan yang tepat.

2. Monitoring Plant, PLC secara terus menerus memonitor status suatu

sistem (misalnya temperatur, tekanan, tingkat ketinggian) dan

mengambil tindakan yang diperlukan sehubungan dengan proses yang

dikontrol (misalnya nilai sudah melebihi batas) atau menampilkan

pesan tersebut pada operator.

Sedangkan fungsi PLC secara khusus adalah dapat memberikan input ke

Computerized Numerical Control (CNC). Beberapa PLC dapat memberikan input

ke CNC untuk kepentingan pemrosesan lebih lanjut. CNC bila dibandingkan

dengan PLC mempunyai ketelitian yang lebih tinggi dan lebih mahal harganya.

CNC biasanya dipakai untuk proses finishing, membentuk benda kerja, moulding

dan sebagainya.
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2.1.3.3 Prinsip Kerja Programmable Logic Controller (PLC)

Prinsip kerja sebuah PLC adalah menerima sinyal masukan proses yang

dikendalikan antara lain saklar, tombol dan sensor lalu melakukan serangkaian

instruksi logika terhadap sinyal masukan tersebut sesuai dengan program yang

tersimpan dalam memori lalu menghasilkan sinyal keluaran untuk mengendalikan

actuator, alarm, selenoid atau peralatan lainnya. Dimana nantinya dapat untuk

mengoperasikan secara otomatis sistem proses kerja yang dikontrol tersebut.

Sebuah PLC bekerja secara kontinyu dengan cara men-scan program.

Ibaratnya kita bisa mengilustrasikan satu siklus scan ini menjadi 3 langkah atau 3

tahap. Bagian-bagian lainnya hanya memeriksa system dn meng-update pencacah

internal (updating internal counter) dan nilai timer. Berikut ini adalah 3 tahap

penting dari siklus penelusuran PLC sebagaimana ditunjukkan pada gambar

dibawah ini.

Gambar 2.8 Proses scanning program PLC
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Proses operasi PLC adalah sebagai berikut:

1. Periksa Status Masukan (check input status)

Pada langkah ini, PLC melihat keadaan setiap masukan yang ada untuk

menentukan kondisi setiap masukan tersebut apakah pada keadaan aktif

atau non-aktif.Dengan kata lain, apakah sensor/switch yang terhubung

dengan masukan pertama aktif/tidak aktif, masukan kedua aktif/tidak

aktif, dan sebagainya. PLC akan menyimpan data masukan tersebut ke

memori untuk dapat digunakan pada langkah berikutnya.

2. Eksekusi Program (execute program)

Pada langkah ini, PLC akan mengeksekusi program yang tersimpan di

dalam memori per instruksi. Misalkan program menginginkan jika

masukan pertama aktif, maka program tersebut harus mengaktifkan

keluaran pertama. Dikarenakan program yang ada telah mengetahui

masukan-masukan mana saja yang aktif/tidak aktif dari langkah

sebelumnya, maka program tersebut akan menentukan apakah keluaran

pertama harus diaktifkan atau dimatikan berdasarkan kondisi dari

masukan pertama yang diterimanya/ setelah itu, program akan

menyimpan hasil eksekusi tersebut dengan tujuan untuk dapat digunakan

pada langkah selanjutnya.

3. Perbaharuan Status Keluaran (update output status)

Pada langkah ini, PLC memperbaharui kondisi keluaran berdasarkan

masukan mana yang aktif pada langkah pertama dan hasil eksekusi
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program yang dimasukan pada langkah pertama dan hasil eksekusi

program yang dimasukan pada langkah kedua. Berdasarkan contoh pada

langkah kedua, PLC akan megaktifkan keluaran pertama karena masukan

pertama sudah pernah aktif dan program menginstruksikan agar keluaran

pertama diaktifkan pada saat kondisi ini benar. Setelah langkah ini dilalui,

PLC akan kembali ke langkah pertama dan menelusuri ulang langkah-

langkah tersebut secara terus-menerus. Satu kali penelusuran dapat di

artikan sebagai waktu yang diperlukan untuk mengeksekusi 3 langkah

tersebut.

2.1.3.4 Komponen-komponen Programmable Logic Controller(PLC)

PLC sesungguhnya merupakan sistem mikrokontoler khusus untuk

industri, artinya seperangkat perangkat lunak dan keras yang diadaptasi untuk

keperluan aplikasi dalam dunia industri. Secara umum PLC memiliki bagian-

bagian yang sama dengan komputer maupun mikrikontroller, yaitu CPU, memori

dan input/output. Susunan komponen PLC dapat dilihat pada gambar berikut:

Gambar 2.9 Susunan Komponen PLC

https://belajarplconline.wordpress.com/2010/04/13/komponen-
komponen-pada-plc/

https://belajarplconline.wordpress.com/2010/04/13/komponen-komponen-pada-plc/
https://belajarplconline.wordpress.com/2010/04/13/komponen-komponen-pada-plc/
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Adapun penjelasan dari komponen-komponen dasar PLC adalah sebagai

berikut:

1. Unit Central Processing Unit (CPU) merupakan bagian yang berfungsi

sebagai otak bagi sistem. CPU ini berfungsi untuk melakukan

komunikasi dengan PC atau Console, interkoneksi pada setiap bagian

PLC, mengeksekusi program-program, serta mengatur input dan

output sistem.

2. Unit Memori, memori didalam PLC digunakan untuk menyimpan data

sementara dan menyimpan program yang harus dijalankan, dimana

program tersebut merupakan hasil terjemahan dari ladder diagram

yang dibuat oleh user. Sistem memori pada PLC juga mengarah pada

teknologi flash memory. Dengan menggunakan flash memory maka

akan sangat mudah bagi pengguna untuk melakukan programming

maupun reprogramming secara berulang-ulang. Selain itu pada flash

memory juga terdapat Erasable Programmable Read Only Memory

(EPROM) yang dapat dihapus berulang-ulang. Sistem memori dibagi

dalam blok-blok dimana masing-masing blok memiliki fungsi sendiri-

sendiri. Beberapa bagian dari memori digunakan untuk menyimpan

status input dan output, sementara bagian memori yang lain digunakan

untuk menyimpan variable yang digunakan pada program seperti nilai

timer dan counter. PLC memiliki suatu rutin kompleks yang digunakan

untuk memastikan memori PLC tidak rusak. Hal ini dapat dilihat lewat

lampu indikator pada PLC.
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3. Unit Power Supply atau unit catu daya untuk memberikan tegangan

pada PLC. Tegangan masukan pada PLC biasanya sekitar 24 VDC

atau 220 VAC, dikonversi menjadi tegangan rendah 5 VDC yang

dibutuhkan oleh prosesor dan rangkaian-rangkaian dalam input/output

interface. Pada PLC yang besar, catu daya biasanya diletakkan

terpisah. Catu daya tidak digunakan untuk memberikan daya secara

langsung ke input maupun output, yang berarti input dan output murni

merupakan saklar. Jadi pada alat trainer kit PLC ini menyediakan

sendiri catu daya untuk input dan output pada PLC.Kegagalan dalam

pemenuhan tegangan oleh power supply dapat menyebabkan

kegagalan operasi PLC. Untuk itu diperlukan adanya baterai cadangan

dengan tujuan agar pada saat tegangan turun, daya yang ada pada

memori tidak hilang.

4. Unit pemrograman, komponen pemrograman merupakan alat yang

digunakan untuk berkomunikasi dengan PLC. Unit pemrograman

mempunyai beberapa fungsi yaitu:

1) RUN, untuk mengendalikan suatu proses saat progam dalam

keadaan aktif.

2) OFF, untuk mematikan PLC sehingga program dibuat tidak dapat

dijalankan.

3) Monitor, untuk mengetahui keadaan suatu proses yang terjadi dalam

PLC.
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4) Program, menyatakan suatu keadaan dimana pemrograman/monitor

digunakan untuk membuat suatu program.

5) Com atau Common, untuk menunjukkan bahwa bagian ini

digunakan secara bersama-sama oleh bagian lainnya. Dibagian com

ini diisi (+, -, ground, atau fase) menyesuaikan dimana com ini

berada. Pada bagian input PLC, ada garis putih tebal pada bagian

dekat dengan com input plc sampai input 11, dan seterusnya chanel

1 dari 00-05, pada bagian input garis putih tebal ini hanya

memisahkan chanel 0 dan chanel 1 saja, namun kedua chanel input

tersebut hanya memiliki satu com saja pada chanel tersebut akan

memiliki tegangan. Pada umunya PLC OMRON input diskret hanya

mengenal on off dengan sinyal VDC, pada input diskret hanya

tersedia satu com saja karena kebutuhan tegangannya sama, ketika

memberi input com positif maka kondisi negatif pada input lainnya

agar input pada PLC aktif, dan sebaliknya jika isi com dengan

negatif maka input lainnya harus diberi masukan positif untuk

mengaktifkannya. Dalam hal ini lebih baik com diberi negatif (0

VDC), karena umumnya sensor aktif akan memiliki tegangan positif,

sehingga jika diberi com dengan positif maka ketika sensor aktif

maka input PLC akan off dan saat sensor nonaktif input PLC akan

on, meskipun tidak masalah, tapi hal ini akan sedikit mengganggu

ketika memprogram PLC, karena bisa terbalik-balik kondisinya.
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Pada com bagian output diskret berbeda, jumlah com lebih banyak,

hal ini karena kebutuhan output bisa berbeda kebutuhan jenis arus

maupun tegangannya, misalnya ingin menghidupkan LED dan juga

lampu listrik, tentu tidak bisa menggunakan com secara bersamaan,

karena antara LED dan lampu listrik meiliki jenis arus berbeda dan

tegangan yang jauh berbeda. Untuk mengetahui com mana saja yang

digunakan output, maka lihat garis putih tebal yang ada pada bagian

output, karena garis tebal inilah yang memisahkan antar com. Pada

com pertama hanya digunakan oleh output 00, com kedua hanya

digunakan oleh output 01, sedangkan com ketiga digunakan oleh

output 002 dan 003, begitu seterusnya.

6) Unit Input/Output, menyediakan antarmuka yang menghubungkan

sistem dengan dunia luar, melalui unit input/output, program-

program dimasukkan dari panel program. Setiap titik input/output

memiliki sebuah alamat unik yang dapat digunakan oleh CPU.

Selain komponen dasar, PLC juga memiliki komponen tambahan

yang dapat membuat fungsi maupun kinerjanya menjadi semakin

optimal. Hal tersebut karena sebuah PLC tersusun dari ratusan

bahkan ribuan relay, counter, timer, dan juga memori. Setiap PLC

biasanya memiliki jumlah masukan dan keluaran yang terbatas. Jika

diinginkan, jumlah ini dapat ditambahkan menggunakan sebuah

modul keluaran dan masukan tambahan (I/Oexpension atau I/O

extension module).
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Untuk mengoperasikan PLC dibutuhkan juga komponen utama, yaitu:

1. Komponen Peralatan Input (Input Device), adalah komponen-

komponen yang akan memberikan masukan logika kepada CPU PLC,

yang biasanya berupa saklar-saklar ON (ON switch), misalnya

Pushbutton, Limit Switch, Level Switch, Flow Switch, Elektronic

Switch, dan lain-lain. Disamping itu juga dibutuhkan input sumber

daya listrik.

(a) (b)

Gambar 2.10 (a) Komponen Peralatan Input,

(b) Simbol-simbol Komponen Input

2.1.3.5 Bahasa Pemrograman Programmable Logic Controller (PLC)

Pemprograman PLCdapat dibuat dengan menggunakan beberapa cara

yang disebut bahasa pemrograman. Bentuk program berbeda-beda sesuai dengan

bahasa pemrograman yang digunakan. Bahasa pemrograman tersebut antara lain:

diagram ladder, kode mneumonic, diagram blok fungsi (FBL), dan teks terstruktur.
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Beberapa merk PLC hanya mengembangkan program diagram ladder dan kode

mneumonic. Maka dari itu saya menggunakan bahasa pemrograman diagram

ladder.

1. Diagram Ladder

Pada sebuah PLC, diagram kontrol yang digunakan adalah diagram

ladder. Diagram ladder adalah sebuah bahasa diagram pengendali

otomatis yang menggunakan simbol-simbol. Pada awalnya diagram

ladder hanya terdiri dari komponen dasar seperti kontak A (Normally

Open), kontak B (Normally Close), kumparan keluaran, timer,

pencacah dan lain-lain. Selain itu ada juga perintah-perintah

aritmatika yang digunakan seperti penjumlahan, pengurangan,

perkalian, dan pembagian. Diagram ladder terdiri atas sebuah garis

vertikal di sebelah kiri yang disebut bus bar, dengan garis bercabang

ke kanan yang disebut rung. Sepanjang garis instruksi, ditempatkan

kontak-kontak yang mengendalikan / mengkondisikan instruksi lain di

sebelah kanan. Kombinasi logika kontak-kontak ini menentukan

kapan dan bagaimana instruksi di sebelah kanan dieksekusi.

Gambar 2.11 Ladder Diagram
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2. Kode Mneumonic

Kode mneumonic memberikan informasi yang sama seperti halnya

diagram ladder. Sesungguhnya program yang disimpan di dalam

memori PLC dalam bentuk mneuomonic, bahkan meskipun program

dibuat dalam bentuk diagram ladder. Mneumonic sendiri terdiri atas

tiga unsur yaitu: alamat, instruksi, dan operand.

1) Alamat adalah nomor yang menunjukan lokasi, instruksi, atau data

dalam daerah mneumonic. Instruksi harus disusun secara berurutan

dan menempatkannya dalam alamat yang tepat sehingga seluruh

instruksi dilaksanakan mulai dari alamat terendah hingga alamat

tertinggi dalam program.

2) Instruksi adalah perintah yang harus dilaksanakan PLC dan hanya

dapat melaksanakan instruksi yang ditulis menggunakan ejaan yang

sesuai. Oleh karena itu, pembuat program harus memperhatikan tata

cara penulisan instruksi.

3) Operand adalah nilai berupa angka yang ditetapkan sebagai data

yang digunakan untuk suatu instruksi. Operand dapat dimasukkan

sebagai konstanta yang menyatakan nilai angka nyata atau

merupakan alamat data dalam memori.
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Berikut ini contoh program mneumonic:

Tabel 2.1 ContohMneumonic

Alamat Instruksi Operand

00000 LD 0.00

00001 AND 0.01

00002 OR 0.02

00003 LD NOT 0.03

00004 OR 0.04

00005 AND LD -

00006 AND NOT 0.05

00007 OUT 1.00

00008 END (01)

3. Struktur Daerah Memori

Program pada dasarnya adalah pemrosesan data dengan berbagai

instruksi pemrograman. Data disimpan dalam daerah memori PLC.

Pemahaman daerah data, disamping pemahaman terhadap berbagai

jenis instruksi merupakan hal yang sangat penting, karena dari segi

inilah intisari pemahaman terhadap program. Data yang merupakan

operand suatu instruksi dialokasikan sesuai dengan jenis datanya.

Tabel di bawah ini ditunjukan daerah memori PLC CP1E sebagai

berikut:



46

Tabel 2.2 Daerah Memori PLC CP1E

Daerah Data Channel/Words Bit

IR

Daerah Input IR 000 s.d IR 009 IR 000.00 s.d IR 009.15

Daerah Output IR 010 s.d IR 019 IR 010.00 s.d IR 019.15

Daerah 'kerja'
IR 020 s.d IR 049 IR 020.00 s.d IR 049.15

IR 200 s.d IR 227 IR 200.00 s.d IR 227.15

SR SR 228 s.d SR 255 SR 228.00 s.d SR 255.15

TR --- TR 0 s.d TR 7

AR AR 00 s.d 23 AR 00.00 s.d AR 23.15

LR LR 00 s.d LR 15 LR 00.00 s.d LR 15.15

TIM/CNT TC 000 s.d 255

4. Simbol Diagram Ladder

Berikut adalah simbol-simbol diagram ladder:

1) Load / LD

Merupakan jenis kontak normally open, yaitu kondisi di mana

kontaknya akan tertutup (ON) jika di aliri arus listrik. Load atau LD

dalam kode mneumonik biasa juga disebut eXamine if on (XIO). Jika

ada input (secara fisik) ON, maka simbolnya juga akan ON. Kondisi

ON ini nilai logikanya adalah 1. Dibawah ini simbol Load (LD).

Gambar 2.12 Simbol Load (LD)
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2) Load Not / LD NOT

Merupakan jenis kontak NC (Normally Close), kadang juga disebut

Load Not atau eXamine If Close (XIC). Jika tidak ada input maka

simbolnya dalam kondisi tertutup (ON), sedang jika ada input maka

akan terbuka (OFF).

Gambar 2.13 Simbol Load Not (LD NOT)

3) AND

Ialah menghubungkan dua atau lebih input dalam bentuk normally

open secara seri pada garis instruksi yang sama.

Gambar 2.14 Simbol AND

4) AND NOT

Ialah menghubungkan dua atau lebih input dalam bentuk normally

close seri pada garis instruksi yang sama.

Gambar 2.15 Simbol AND NOT
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5) OR

Ialah menghubungkan dua atau lebih input dalam bentuk normally

open secara paralel. Artinya dalam garis instruksi yang berbeda

kemudian bergabung lagi dalam satu garis instruksi yang sama.

Gambar 2.16 Simbol OR

6) OR NOT

Ialah menghubungkan dua atau lebih input dalam bentuk normally

close secara paralel. Artinya dalam garis instruksi yang berbeda

kemudian bergabung lagi dalam satu garis instruksi yang sama.

Gambar 2.17 Simbol OR NOT

7) OUTPUT / OUT

Digunakan untuk mengendalikan status bit operand sesuai dengan

kondisi eksekusi. Dengan instruksi OUTPUT, bit operand akan ON

selama kondisi eksekusinya ON dan akan OFF selama kondisi

eksekusinya OFF.
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Gambar 2.18 Simbol OUTPUT / OUT

8) OUTPUT NOT / OUT NOT

Digunakan untuk mengendalikan status bit operand sesuai dengan

kondisi eksekusi. Dengan instruksi OUTPUT NOT, bit operand akan

ON selama kondisi eksekusinya OFF dan akan OFF selama kondisi

eksekusinya ON.

Gambar 2.19 Simbol OUTPUT NOT / OUT NOT

9) END

Digunakan untuk menandakan akhir dari suatu program.

Gambar 2.20 Simbol END (01)

5. Instruksi Blok Logika

Jika rangkaian logika tidak dapat diwujudkan dengan instruksi AND,

AND NOT, OR, atau OR NOT saja, maka perlu menggunakan instruksi

blok logika. Perbedaannya adalah bahwa instruksi AND, AND NOT, OR,

atau OR NOT mengkombinasikan antar kondisi eksekusi dengan suatu
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bit operand, sedangkan instruksi blok logika yang terdiri dari instruksi

AND LOAD dan OR LOAD mengkombinasikan kondisi eksekusi

dengan kondisi eksekusi terakhir yang belum digunakan. Instruksi blok

logika tidak diperlukan dalam program diagram ladder, tetapi diperlukan

hanya pada program mneumonik.

1) AND Load / AND LD

Instruksi AND LOAD meng-AND-kan kondisi eksekusi yang

dihasilkan oleh dua blok logika.

Gambar 2.21 Simbol AND LOAD / AND LD

Tabel 2.3 Mneumonik penggunaan AND LOAD

Alamat Instruksi Operand

00000 LD 00000

00001 OR 00001

00002 LD 00002

00003 OR NOT 00003

00004 AND LD

2) OR Load / OR LD

Instruksi OR LOAD meng-OR-kan kondisi eksekusi yang

dihasilkan oleh dua blok logika.
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Gambar 2.22 Simbol OR LOAD / OR LD

Tabel 2.4 Mneumonik Penggunaan OR LOAD

Alamat Instruksi Operand

00000 LD 00000

00001 OR 00001

00002 LD 00002

00003 AND NOT 00003

00004 OR LD

6. Garis Percabangan Instruksi

Jika suatu garis instruksi harus bercabang dua atau lebih, adakalanya

perlu menggunakan bit interlock atau TR untuk menjaga kondisi pada

titik percabangan. Hal ini disebabkan kembali lagi ke titik percabangan

kemudian mengerjakan instruksi pada garis instruksi berikutnya (pada

percabangan tersebut). Jika suatu kondisi disisipkan pada garis

percabangan instruksi atau disisipkan setelah titik percabangan, maka

kondisi eksekusi bisa berubah selama proses tersebut, sehingga tidak

dimungkinkan program berjalan sesuai dengan yang diharapkan.
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Diagram A Penggambaran Benar Diagram B Penggambaran Salah

Gambar 2.23 Contoh Ladder Diagram Dengan Titik Percabangan

Tabel 2.5 Mneumonik Penggunaan instruksi titik percabangan BENAR dan

SALAH

Pada diagram A kondisi eksekusi yang muncul pada titik cabang tidak

dapat berubah sebelum kembali ke garis percabangan, dengan kata lain

out 1 tidak dapat mengubah kondisi eksekusi pada titik cabang,

sehingga garis percabangan akan dikerjakan dengan benar. Sedangkan

Alamat Instruksi Operand

00000 LD 00000

00001 Out 1 -

00002 AND 00002

00003 Out 2 -

Alamat Instruksi Operand

00000 LD 00000

00001 AND 00001

00002 Out 1 -

00003 AND 00002

00004 Out 2 -
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pada diagram B, terdapat sebuah kondisi antara titik cabang dengan out

1, hal ini menyebabkan kondisi eksekusi titik cabang 00001-nya jika

proses ini 00001 mengalami perubahan kondisi, sehingga tidak

mungkin mendapat hasil yang diinginkan, maka untuk mengatasi hal ini

dibutuhkan bit TR atau interlock (IL (02)) atau interlock clear

(ILC(03)).

1) Bit TR

Area TR menyediakan delapan bit, TR0 sampai TR7, yang dapat

digunakan untuk menyimpan sementara kondisi eksekusi pada titik

cabang. Jika sebuah bit TR dipasang pada titik cabang, maka kondisi

eksekusi saat itu akan disimpan pada bit TR yang bersangkutan. Saat

kembali ke titik cabang bit TR, yang sudah menyimpan kondisi

eksekusi sebelumnya, akan mengembalikan kondisi eksekusi seperti

semula saat pertama kali eksekusi mencapai titik cabang.

Gambar 2.24 Simbol bit TR
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Tabel 2.7 Mneumonik Penggunaan bit TR

Dari gambar di atas out 1 akan ON jika TR0 dan 00001 keduanya

dalam kondisi ON. Demikian juga out 2 akan ON jika TR0 dan

00002 keduanya dalam kondisi ON.

7. Timer (TIM) dan Counter (CNT)

Timer (TIM) dan Counter (CNT) Timer/Counter pada PLC berjumlah

512 buah yang bernomor TC 000 sampai dengan TC 511 (tergantung tipe

PLC). Dalam satu program tidak boleh ada nomor Timer/Counter yang

sama.

Alamat Instruksi Operand

00000 LD 00000

00001 OUT TR 0

00002 AND 00001

00003 OUT 1 -

00004 LD TR 0

00005 AND 00002

00006 OUT 2 -
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Nilai Timer/Counter pada PLC bersifat menghitung mundur dari nilai

awal yang ditetapkan oleh program, setelah mencapai angka nol maka

kontak NO timer/counter akan ON. Timer mempunyai batas antara 0000

sampai dengan 9999 dalam bentuk BCD dan dalam orde 100 ms / 0,1

detik. Sedangkan untuk counter mempunyai orde angka BCD dan

mempunyai batas antara 0000 sampai dengan 9999.

1) Timer (TIM)

Pada sebagian besar aplikasi kontrol terdapat peralatan untuk beberapa

aspek kontrol pewaktuan (timing). PLC mempunyai fasilitas pewaktuan

untuk program yang dapat digunakan. Metode umum dari pemrograman

sebuah rangkaian timer adalah untuk menentukan interval yang dihitung

dari suatu kondisi atau keadaan.

Cara kerja dari instruksi Timer adalah ketika Timer (TIM 0000)

mendapatkan input selama SV (set value) akan mengaktifkan kontak-

kontaknya (T0000).

Catatan: dalam satu program alamat nomer Counter dan Timer tidak

boleh sama. Misal jika alamat nomer counter 0000 maka alamat Timer

tidak boleh meggunakan alamat 0000. Set value timer adalah set x 10.

Sehingga misal set value yang diinginkan 10 detik maka penulisan set

valuenya adalah 10 detik x 10 = #100. Semua SV, termasuk yang diset

dari luar harus dalam BCD (Binary Coded Decimal), yaitu bilangan

desimal yang dikode biner.
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Penulisan SV harus diawali dengan tanda (#).

Gambar 2.25 Simbol Timer

Keterangan :

Timer aktif bila kondisi eksekusi ON dan reset bila OFF. Pertama dieksekusi

TIM mengukur SV dalam orde 0,1 detik.

Gambar 2.26 Contoh Penggunaan Timer

Tabel 2.8 Mneumonik Penggunaan Instruksi titik TIMER

Alamat Instruksi Operand

00000 LD 0.00

00001 AND NOT 0.01

00002 TIM 000

00003 #050

00004 LD T000

00005 OUT 100.00
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2) Counter (CNT)

Instruksi (perintah) counter dapat digunakan sebagai rangkaian

penghitung/pencacah pada rangkaian relay. Cara kerja instruksi counter

adalah ketika counter (CNT 0000) mendapat input sebanyak dari set

value maka akan mengaktifkakn contact C0000 sehingga output (1.00)

akan aktif. Sedangkan untuk mereset counter bisa menggunakan input

0.01.

Simbol, di mana:

S = input untuk mengaktifkan counter

r(reset) = input yang harus diberikan agar nilai counter

kembali ke semula.

XXX = nomer counter

YYYY = nilai counter

Gambar 2.27 Simbol Counter
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Gambar 2.28 Contoh Penggunaan Counter

Tabel 2.9 Mneumonik Penggunaan Instruksi COUNTER

Counter reversible adalah instruksi (perintah) counter dapat

digunakan sebagai rangkaian penghitung/pencacah baik menghitung

naik maupun menghitung turun dalam satu instruksi pada rangkaian

relay.

Alamat Instruksi Operand

00000 LD 0.00

00001 LD 0.01

00002 CNT 001

00003 CNT #0002

00004 LD C0001

00005 OUT 100.00
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Gambar 2.29 Simbol Counter Reversible

Gambar 2.30 Contoh Penggunaan Counter Reversible

Tabel 2.10 Mneumonik Penggunaan Instruksi Counter Reversible

Alamat Instruksi Operand

00000 LD 00000

00001 LD 00001

00002 LD 00002

00003 CNTR (012) 0000

00004 #0003

00005 LD C0000

00006 OUT 100.00

Kode Mneumonik (Instruction List) memberikan informasi yang sama

persis seperti halnya diagram ladder. Sesungguhnya, program yang

disimpan di dalam memori PLC dalam bentuk mneumonik, bahkan
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meskipun program dibuat dalam bentuk diagram ladder. Oleh karena

itu, memahami kode mneumonik itu sangat penting. Berikut ini

contoh ladder diagram beserta program mneumoniknya:

Gambar 2.31 Ladder Diagram

Tabel 2.11 Program Mneumonik

Alamat Instruksi Operand

00000 LD 00000

00001 OR 01000

00002 AND NOT 00001

00003 OUT 01000

00004 TIM 000 #050

00005 LD TIM 000

00006 OUT 01001

00007 END (01
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2.1.3.6 Mode Operasi PLC

Operasi PLC dikategorikan dalam tiga mode yaitu: PROGRAM,

MONITOR, dan RUN. Pilihan mode operasi harus dipilih dengan tepat sesuai

dengan aktifitas dalam sistem kendali PLC.

Mode PROGRAM digunakan untuk membuat dan mengedit program,

menghapus memori, atau mengecek kesalahan program. Pada mode ini, program

tidak dapat dieksekusi/ dijalankan.

Mode MONITOR digunakan menguji operasi sistem, seperti memonitor

status operasi, melaksanakan instruksi force set dan force reset bit I/O, merubah

SV (Set Value) dan PV (Present Value) timer dan counter, merubah data kata, dan

mengedit program online.

Mode RUN digunakan untuk menjalankan program. Status operasi PLC

dapat dimonitor dari peralatan pemrogram, tetapi bit tdk dapat di paksa set/ reset

dan SV/PV timer dan counter tidak dapat diubah.

2.1.3.7 Jenis-jenis Alat Pemrogram

Ada beberapa jenis alat untuk memasukkan program ke dalam PLC yaitu

komputer yang dilengkapi dengan software ladder misalnya CX-Programmer,

Konsol Pemrogram, dan Programmable Terminal. Dengan software ladder CX-

Programmer, program yang dimasukkan ke dalam PLC dapat berbentuk diagram

ladder atau kode mneumonik, tetapi Konsol Pemrogram hanya dapat memasukkan

program dalam bentuk kode mneumonik.
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2.1.3.8 Sambungan Alat Pemrogram

PLC dapat disambung ke Konsol Pemrogram atau komputer dengan

software ladder seperti CX-Programmer, SSS (Sysmac Support Software), atau

Syswin, dan Programmable Terminal.

1. Sambungan Konsol Pemrogram

Hubungkan Konsol Pemrogram ke port peripheral PLC. Konsol

Pemrogram tidak dapat disambung ke port RS-232C. PLC akan otomatis

berkomunikasi dengan Konsol Pemrogram tanpa memandang metode

komunikasi yang dipilih pada saklar komunikasi PLC.

Gambar 2.32 Sambungan Konsol Pemrograman

2. Sambungan Komunikasi Host Link

Komunikasi Host Link adalah komunikasi antara PLC dan komputer

yang didalamnya diinstal software ladder. Komputer dapat disambung

ke port peripheral atau port RS-232C PLC. Port peripheral dapat
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beroperasi dalam mode Host Link atau mode peripheral bus. Port RS-

232C beroperasi hanya dalam mode Host Link.

Komputer dapat disambung ke port peripheral PLC dengan adapter

RS- 232C : CQM1-CIF02 atau CPM1-CIF01.

Gambar 2.33 Sambungan Komunikasi Host Link

3. Sambungan Komunikasi NT Link

Komunikasi NT Link adalah komunikasi antara PLC dan

Programmable Terminal.

Pada Link NT 1:1, PLC dapat disambung langsung ke Programmable

Terminal yang disambung ke port RS-232C. Ia tidak dapat disambung ke

port peripheral.

Gambar 2.34 Sambungan Komunikasi NT Link
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Penjelasan tentang sambungan alat pemrogram ini yang sesuai dengan

alat trainer PLC ini di komunikasikan antara PLC dan komputer yang didalamnya

diinstal software ladder dengan menggunakan sambungan host link. Komputer

dapat disambung ke port peripheral atau port RS-232C PLC. Program PLC

berbentuk Ladder atau kode mneumonic yang dituliskan ke dalam PLC dengan

menggunakan Programming Device. Beberapa program untuk PLC adalah syswin

dan Cx-Programmer. Dan yang saya gunakan adalah CX-Programmer.

2.1.4 Software CX-Programmer

2.1.4.1 Memasukkan Program Menggunakan Cx-Programmer

CX Programmer adalah software ladder untuk PLC merk OMRON. Ia

beroperasi di bawah sistem operasi Windows, oleh sebab itu pemakai software ini

diharapkan sudah familier dengan sistem operasi Windows antara lain untuk

menjalankan software program aplikasi, membuat file, menyimpan file, mencetak

file, menutup file, membuka file, dan keluar dari (menutup) software program.

Ada beberapa persyaratan minimum yang harus dipenuhi untuk bisa

mengoperasikan CX Programmer secara optimal yaitu:

1. Komputer IBM PC/AT kompatibel

2. CPU Pentium I minimal 133 MHz

3. RAM 32 Mega bytes

4. Hard disk dengan ruang kosong kurang lebih 100 MB

5. Monitor SVGA dengan resolusi 800 x 600
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2.1.4.2 Menjalankan Cx-Programmer

Ada banyak cara untuk menjalankan suatu software termasuk CX

Programmer. Berikut ini ditunjukkan cara umum menjalankan software dalam

sistem operasi Windows.

Klik tombol Start > Program > OMRON > CX-Programmer > CX-

Programmer. Akan tampil Layar CX Programmer sebagai berikut:

Gambar 2.35 Layar Interface Utama

Tabel 2.12 Menu/Command Pada Layar CX-Programmer Utama

Menu/Command Fungsi

File>New Membuat file baru

File>Open Membuka file

File>Exit Keluar dari CX-Programmer
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View>Toolbar Menampilkan/ menyembunyikan toolbar

Tool>Option Mengatur beberapa opsi :

Help Topic Meminta penjelasan menurut topik

Help Content Meminta penjelasan menurut isi

2.1.4.3 Membuat File Baru

Klik File, New untuk membuat file baru.Kotak dialog Change PLC

ditampilkan.

Gambar 2.36 Kotak Dialog Merubah PLC

Pada kotak Device Type, klik tanda  untuk memilih tipe PLC yang

akan digunakan. Kemudian klik Setting untuk memilih jumlah input/output PLC.

Kotak dialog Device Type Setting ditampilkan.
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Gambar 2.37 Dialog Device Type Setting

Pada General, CPU Type, klik tand  untuk memilih jumlah I/O PLC,

OK. Kembali ke kotak dialog Change PLC, pilih OK. Layar CX-Programmer

ditampilkan.

Project Workspace

Output Ladder Diagram

Gambar 2.38 Layar CX-Programmer



68

Secara default ada tiga window tampil secara bersamaan, yaitu:

1. Window Diagram Ladder

Di sini, diagram ladder akan digambar.

2. Window Project Workspace

Window Project Workspace (Ruang Kerja Proyek) menampilkan

proyek sebagai struktur hierarkhi antara PLC dan rincian program.

Penjelasan beberapa obyek dalam struktur ini sebagai berikut:

a. PLC Menampilkan dan merubah tipe PLC, menampilkan mode

operasi PLC

b. Symbols Global Menampilkan simbol global, yaitu simbol

yang digunakan secara umum untuk semua program.

Yang dimaksud symbols adalah operand dalam

daerah memori PLC.

c. Program Menampilkan nama program (proyek)

d. Symbol Local Menampilkan simbol lokal, yaitu simbol yang

digunakan hanya pada program yang sedang aktif.

e. Section Menampilkan/ menyembunyikan tampilan diagram

ladder.

3. Window Output

Window output akan menampilkan kesalahan dalam menulis

diagram ladder. Kesalahan juga ditunjukkan secara langsung dalam
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window diagram ladder, dimana akan muncul tampilan warna merah

pada bagian program yang salah.

2.1.4.4 Menggambar Diagram Ladder

CX-Programmer membebaskan pemakai untuk membuat program dalam

bentuk diagram ladder atau mneumonik. Tetapi, akan lebih baik menggunakan

program diagram ladder.Pemakai juga dibebaskan untuk menggunakan operasi

toolbar, atau shortcut keyboard.

Tabel 2.13 Fungsi Masing-Masing Toolbar dan Shortcut

Menu/ Comand Toolbar Shortcut
Insert>Contact>Normally Open C

Insert>Contact>Normally Closed /

Insert>Vertical>Up U

Insert>Vertical>Down V

Insert>Horizontal -

Insert>Coil>Normally Open O

Insert>Coil>Normally Closed Q

Insert>Instruction I

Misalnya, program ladder di bawah ini akan dibuat menggunakan CX-

Programmer !
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Gambar 2.39 Program Diagram Ladder

Lakukan prosedur persiapan hingga tampil layar CX-Programmer seperti

dijelaskan diatas.

1. Tempatkan kursor pada sel kiri atas. Klik Insert > Contact >

Normally Open atau , maka muncul kotak dialog New Contact

Gambar 2.40 Kotak Dialog New Contact

Pada kotak Name or address, ketik ‘1’ untuk menulis operand 0.01.

Klik OK atau tekan Enter. Kursor akan bergeser ke kanan satu sel.

2. Klik Insert > Contact > Normally Closed atau , ketik ‘0’

untuk menulis operand 0.00, Klik OK atau tekan Enter.
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3. Klik Insert > Coil > Normally Open atau , maka muncul

kotak dialog New Coil :

Gambar 2.41 Kotak Dialog New Coil

4. Ketik ‘1000’ untuk menulis operand 10.00. Klik OK atau tekan

Enter.

5. Tekan Enter, untuk menambah baris pada rung yang sama.

Kursor berpindah ke awal baris baru.

6. Klik Insert > Contact > Normally Open atau , ketik ‘1000’,

OK.

7. Klik Insert > Vertical > Up atau diantara kontak NO 0.01 dan

kontak NC 0.00.

8. Tekan tombol Esc untuk menon-aktifkan toolbar yang sedang

aktif. Pindahkan kursor ke awal rung baru dengan menggunakan
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tombol anak panah. Begitu kursor berpindah ke rung baru, diagram

ladder secara otomatis mengembang ke kanan.

9. Klik Insert > Instruction untuk menulis instruksi lainnya.

Muncul kotak dialog Instruction sebagai berikut:

Gambar 2.42 Kotak Dialog Instruction

Ketik END pada kotak Instruction, OK. Pindahkan kursor ke rung

baru. Seperti tadi, instruksi END mengembang ke kanan otomatis.

2.1.4.5 Menyimpan File

1. Klik File Save atau untuk menyimpan file. Muncul kotak dialog

Save CX-Programmer File.
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2. Klik pada kotak Save input untuk memilih tempat memori

dimana file akan disimpan. Misalkan file akan disimpan di floppy

disk, maka pilih 3½ Floppy (A:).Pada kotak File Name, tulis nama

file, misalnya ‘M1A’.

Pada kotak Save input type, klik untuk memilih tipe file. Pilih CX-

Programmer Project Files, lalu klik .

Sekarang, file proyek telah disimpan dalam memori dan file ini dapat

diakses setiap saat untuk ditindak-lanjuti.

2.1.4.6 Menutup File

1. Klik File> close untuk menutup file.

2.1.4.7 Membuka File Proyek

1. Klik File>Open atau untuk membuka file yang pernah dibuat.

Klik pada kotak Save input tempat dimana file disimpan.

2. Klik pada kotak file name untuk memilih nama-nama file yang

ada pada memori.

3. Klik pada kotak file of type untuk memilih tipe file, lalu klik

, maka file yang dipilih akan dibuka.
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2.1.4.8 Mentransfer Program ke dalam PLC

Operasi pemrograman PLC dibedakan menjadi operasi offline dan

operasi online. Operasi offline adalah kegiatan pemrograman yang tidak

memerlukan unit PLC, misalnya membuat diagram ladder, menyimpan file.

Operasi online adalah kegiatan pemrograman yang tidak dapat dilakukan tanpa

adanya unit PLC, misalnya mentransfer program, memonitor program, dan

menjalankan program.

Transfer program dibedakan menjadi dua yaitu: Download dan Upload.

Download adalah pemindahan program dari komputer ke PLC, sedangkan upload

adalah pemindahan program dari PLC ke komputer.

Operasi transfer program hanya dapat dilakukan dalam mode operasi

PROGRAM. Jika PLC tidak dalam mode ini, CX-Programmer akan merubah

mode secara otomatis.

Prosedur transfer program dari komputer ke PLC (Download) sebagai

berikut :

1. Klik menu PLC > Work Online, untuk beralih ke operasi online.

Pada layar muncul pesan meminta konfirmasi untuk beralih ke

operasi online.

Klik Yes untuk melanjutkan operasi. Latar belakang layar diagram

ladder berubah menjadi gelap yang menunjukkan anda sedang

berada pada operasi online.
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2. Klik menu PLC > Transfer > To PLC untuk mendownload program.

Muncul kotak dialog yang meminta penjelasan apa saja yang akan di

transfer: program atau setting, atau keduanya. Setelah dipilih, klik

OK.

Gambar 2.43 Download Opinion

Kotak dialog konfirmasi transfer program ditampilkan. Konfirmasi

ini penting karena perintah transfer program akan berpengaruh

terhadap PLC yang disambung.

3. Klik Yes untuk melanjutkan operasi. Pada layar ditunjukkan operasi

transfer program sedang berlangsung. Jika selesai, ada informasi:

Download successful.

Klik OK. Program anda sekarang sudah ada di PLC
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2.2 Penelitian yang Relevan

Penelitian ini peneliti menemukan beberapa kajian yang relevan dengan

pokok permasalahan yang dibahas kelayakan media pembelajaran sebagai berikut :

1. Jurnal Mohammad Hariyadi dan Puput Wanarti R., Jurusan Teknik

Elektro, Universitas Negeri Surabaya dengan judul pembuatan Media

Belajar Trainer PLC pada Mata Diklat PLC di Jurusan Teknik

Elektronika Industri SMK NEGERI 2 Lamongan, menjelaskan tentang

pembuatan trainer dan jobsheet PLC sebagai alat bantu dalam proses

pembelajaran pada standar kompetensi Memprogram peralatan sistem

pengendali elektronik yang berkaitan dengan I/O berbantuan PLC dan

komputer, juga dilakukan untuk mengetahui tingkat kelayakan dan

respon siswa terhadap media pembelajaran. Metode penelitian ini

menggunakan Research and Developmet (R&D). Berdasarkan hasil

penelitian diperoleh kesimpulan bahwa media trainer pada keseluruhan

aspek dinyatakan sangat baik denga rata-rata hasil rating sebesar 85%

dan penilaian terhadap media jobsheet pada keseluruhan aspek

dinyatakan sangat baik dengan rata-rata hasil rating sebesar 86%.

Respon siswa pada keseluruhan aspek yang terdapat didalam media

trainer dan jobsheet dinyatakan sangat baik dengan rata-rata hasil rating

sebesar 84,20%. Hal ini menunjukkan bahwa trainer dan jobsheet PLC

yang dihasilkan layak digunakan sebagai media pembelajaran. Dalam

penelitian ini hanya meneliti kelayakan media trainer dan jobsheet yang
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dikembangkan, sehingga dari hasil penelitian ini tidak diketahui

pengaruh media trainer dan jobsheet terhadap hasil belajar.

2. Jurnal Fery Setyawan dan Bambang Suprianto, Jurusan Teknik Elektro

Universitas Negeri Surabaya dengan judul Pengembangan Trainer dan

Job-sheet sebagai media pembelajaran pada Mata Diklat di Jurusan

Elektronika Industri SMK Negeri 2 Lamongan. Dalam penelitian ini

menggunakan model penelitian Research and Development (R&D).

Analisis data yang dilakukan dengan menggunakan analisis rating, hasil

rating diperoleh adalah sebagai berikut: (1) hasil validasi jobsheet

mendapat penilaian rata-rata 86,25% termasuk dalam kategori sangat

layak, (2) untuk validasi dengan trainer secara keseluruhan mendapatkan

nilai rata-rata 87,28% termasuk dalam kategori sangat layak.maka dapat

disimpulkan bahwa trainer dan josheet layak untuk digunakan. (3) untuk

respon jobsheet mendapatkan penilaian sebesar 80,48% termasuk dalam

kategori sangat baik/menarik, (4) untuk respon trainer mendapatkan

penilaian sebesar 82,97% termasuk dalam kategori sangat bail/menarik.

(5) untuk penilaian onservasi terhadap kemampuan siswa dalam

menggunakan trainer mendapat penilaian sebesar 88% termasuk dalam

kategori sangat baik dan motivasi siswa mendapat penilaian sebesar 82%

termasuk dalam kategori sangat baik. (6) untuk hasil pre-test didapat

nilai rata-rata sebesar 38,08 sedangkan hasil post-test didapat nilai rata-

rata sebesar 61,78, jadi dapat kita simpulkan bahwa terjadi peningkatan

hasil belajar. Dari keenam hasil penelitian ini maka dapat disimpulkan
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trainer dan jobsheet PLC digunakan sebagai media pembelajaran.

Penelitian ini hanya sampai ke tahap uji coba produk. Berdasarkan hasil

uji coba ternyata masih ada beberapa hal yang perlu untuk dilakukan

perbaikan produk. Perbaikan produk yang perlu dilakukan antara lain

dari segi desain trainer. Saran dari peneliti apabila penelitian ini

dilanjutkan ke tahap selanjutnya yaitu revisi produk sampai ke tahap

produksi massal.

2.3 Kerangka Berfikir

2.3.1 Hasil Belajar Tanpa Menggunakan Trainer Kit PLC

Ketercapaian tujuan pembelajaran atau keberhasilan proses pemnbelajaran

sangat tergantung dari strategi pembelajaran yang digunakan oleh guru.

Penggunaan metode dan media pembelajaran yang tidak tepat di dalam setiap

pembelajaran akan menyebabkan akan menyebabkan pesan yang disampaikan

oleh guru tidak mampu ditangkap oleh siswa. Dalam pembelajaran akan terasa

membosankan bagi siswa apabila pada saat pembelajara yang dilakukan guru

bersifat monoton sehingga siswa kurang antusias dalam belajar. Merununnya

minat belajar siswa akan sangat membosankan bagi siswa apabila pada saat

pembelajaran yang dilakukan guru bersifat monoton sehingga siswa kurang

antusias dalam belajar. Menurunnya minat belajar siswa akan sangat berpengaruh

terhadap hasil belajar siswa.

Pemecahan permasalahan-permasalahn tersebut banyak dilakukan

dengan pengembangan media pembelajaran yang bertujuan untuk menarik minat
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dan motivasi siswa dalam mengikuti pelajaran. Pembelajaran Sistem Kendali dan

PLC, meliputi pembelajaran teori dan praktek langsung di bengkel listrik SMK N

1 Kandeman Batang. Sehingga dibutuhkan suatu media yang dapat

memvisualisasikan materi-materi yang diajarkan untuk semakin memperjelas dan

mempermudah pemahaman siswa.

2.3.2 Hasil Belajar Menggunakan Trainer Kit PLC

Melalui media pembelajaran alat trainer ini diharapkan siswa akan lebih

antusias mengikuti pembelajaran karena media ini interaktif dan aplikasi. Media

pembelajaran yang terinteraktif berarti bahwa media tersebut tidak hanya diamati

oleh siswa, tetapi media tersebut juga mengajak siswa untuk berinteraksi seperti

menuliskan hasil percobaan dari penggunaan media tersebut. Sedangkan media

pembelajaran yang aplikatif seperti ini berarti media tersebut layak dapat

digunakan sebagai simulasi atau penerapan dari permasalahan sehari-hari.

Oleh karena itu penggunaan media ini sungguh diharapkan mampu

meningkatkan pertasi dan hasil belajar siswa, sehingga tujuan pembelajaran dapat

tercapai. Media alat trainer ini dapat digunakan untuk membuat pembelajaran

elektronika terapan pada kompetensi dasar menjelaskan konsep dasar sensor

menjadi lebih menarik perhatian siswa akan menambah motivasi siswa untuk

belajar menjadi lebih semangat dan mudah memahami materi dan nantinya

prestasi dan hasil belajar siswa pun akan meningkat.
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v

Gambar 2.44 Kerangka Berpikir
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2.4 Hipotesis

Hipotesis merupakan jawaban terhadap rumusan masalah penelitian, dimana

rumusan masalah telah dinyatakan dalam bentuk kalimat pertanyaan (Sugiyono,

2015: 64). Batas persentase hipotesis penelitian ini terdiri dari ranah kognitif 30%,

ranah psikomotorik 60% dan ranah afektif 10% yang berarti total 100% dengan

nilai KKM 75. Hipotesis dalam penelitian ini adalah sebagai berikut:

HO : Penggunaan trainer kit PLC sebagai media pembelajaran diaggap tidak

efektif meningkatkan hasil belajar siswa tentang pemrograman PLC jika hasil

persentase dari keseluruhan siswa didalam tes ranah kognitif, ranah psikomotorik

dan ranag afektif kelas eksperimen kurang dari 75% .

Ha : Penggunaan trainer kit PLC sebagai media pembelajaran dianggap

efektif meningkatkan hasil belajar siswa tentang pemrograman PLC jika hasil

persentase dari keseluruhan siswa dalam tes ranah kognitif, ranah psikomotorik

dan ranah afektif kelas eksperimen lebih dari atau sama dengan 75% .

HO : 75%

Ha : ≥ 75%
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BAB V

PENUTUP

5.1 Kesimpulan

Dari hasil penelitian, analisi data dan pembahasan diperoleh simpulan

sebagai berikut.

1. Perencanaan dan pembuatan alat trainer kit PLC dapat digunakan sebagai

media pembelajaran pada Jurusan Teknik Instalasi Tenaga Listrik

khususnya pada materi ajar sistem kendali elektronik. Hasil uji kelayakan

alat oleh ahli materi mendapatkan hasil total 88% dalam kategori “Sangat

Layak” untuk digunakan, dan hasil uji kelayakan dari ahli media

mendapatkan hasil total 93% dalam kategori “Sangat Layak” untuk

digunakan.

2. Terdapat perbedaan dan peningkatan hasil belajar antara siswa yang

menggunakan media pembelajaran trainer kit PLC pada kelas eksperimen

yang menggunakan trainer kit PLC dengan kelas kontrol yang tidak

menggunakan media pembelajaran trainer kit PLC pada materi ajar sistem

kendali elektronik siswa kelas XII Jurusan Teknik Instalasi Tenaga Listrik

(TITL) SMK Negeri 1 Kandeman Batang. Pada kelas ekperimen, hasil dari

ranah kognitif (posttest) sebesar 25,5%, ranah psikomotorik sebesar 51,9%,

dan ranah afektif sebesar 8,7% dengan total persentase keseluruhan ranah

sebesar 86,1%. Sedangkan pada kelas kontrol, hasil dari ranah kognitif
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sebesar 23,1%, ranah psikomotorik sebesar 38,9% dan ranah afektif sebesar 6,4%

dengan total keseluruhan ranah yaitu sebesar 68,4%. Hasil dari persentase kelas

eksperimen lebih besar dari hasil persentase kelas kontrol, dengan peningkatan

hasil yang signifikan sebesar 17,7%, maka pada hipotesis penelitian ini Ho ditolak

dan Ha diterima, artinya Penggunaan trainer kit PLC sebagai media pembelajaran

dianggap efektif meningkatkan hasil belajar siswa dalam pemrograman PLC

dengan hasil persentase dari keseluruhan siswa dalam tes ranah kognitif, ranah

psikomotorik dan ranah afektif kelas eksperimen lebih dari atau sama dengan

75% .

5.2 Saran

Berdasarkan simpulan hasil penelitian, maka ada beberapa saran diantaranya:

1. Trainer kit PLC dapat digunakan sebagai media pembelajaran pada mata

pelajaran sistem kendali elektronik kelas XII Jurusan Teknik Instalasi

Tenaga Listrik (TITL) SMK Negeri 1 Kandeman Batang.

2. Trainer kit PLC dapat dikembangkan dengan penambahan output seperti

lampu, motor listrik dan alat timer.
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